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HANDS-ON ACTIVITIES 
 

How do Mittens Keep You Warm (Chromebook and GA4) 
• Go Direct Temperature Sensor 

 
Learning to Use Go! Motion (Chromebook and GA4) 

• Go!Motion Motion Detector 
 

Get a Grip! (Chromebook and LabQuest 2)  
• Go Direct Gas Pressure Sensor 

 
Exploring the Poles (LabQuest 2) 

• Go Direct 3-Axis Magnetic Field Sensor 
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How Do Mittens Keep You Warm? 
Do you have a favorite pair of mittens or gloves? Even if you do not live in a cold place, it is 
possible that you have been somewhere cold or will go to a cold place when you are older. When 
you wear mittens or gloves to keep you warm, where do you think the warmth comes from? In 
this experiment, you are going to find the source of the heat.  

OBJECTIVES 
• Find the temperature of the classroom and the temperature of your hand. 
• Try to predict temperature changes that happen when the Temperature Probe is placed in 

various locations. 
• Test how warm mittens help your hands stay warm.  

MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct Temperature 
mitten 

KEY QUESTION 
Do mittens make heat or hold heat in? 

HYPOTHESIS 
Choose one of the following by checking the box in front of the statement that you think is right. 

□  1. Mittens make their own heat. 

□  2. Mittens hold heat in. 

Why do you think so? 
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PROCEDURE 
1. Get the equipment ready for data collection: 

a. Launch Graphical Analysis.  
b. Connect the Temperature Probe to your Chromebook, computer, or mobile device.  
c. Put the Temperature Probe on the desk and don’t touch it until you are told to do so later 

on.  
2. Click or tap Mode to open Data Collection Settings. Set End Collection to 60 s. Click or tap 

Done.  

3. Do the following to find the temperature of the classroom: 

a. Make sure the Temperature Probe is lying on the desk and hasn’t been touched by 
anyone. If it has been lying there for a few minutes, it will be the temperature of the 
room. 

b. Look at the meter and write down the temperature as the Room temperature in the Data 
Table.  

Data Table Room temperature _____________ °C 

  Prediction 
(°C) 

Maximum temperature  
(°C) 

Was your prediction 
high or low? 

Open hand      

Empty mitten      

Open hand in mitten      

  

4. Make a prediction:  

a. Think about what will happen to the temperature on the screen if you hold the probe 
across the palm of your open hand during data collection. Think about your body 
temperature compared to the room temperature.  

b. Guess how high the temperature will be at the end of data collection and write down your 
prediction in the Data Table.  
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Figure 1    
5. Now, collect data for the temperature of your open palm:  

a. Make sure the temperature values on the meter are very close to the value you recorded 
as the room temperature in your Data Table in Step 3. 

b. Click or tap Collect to start data collection. 
c. Place the tip of the metal part of the probe in the middle of your open palm, holding it by 

the black end with your other hand. Important: The tip of the probe should be gently 
touching your palm. Don’t close your fingers over the metal part.  

d. Hold the probe in the correct position during data collection. 

6. Do the following to find the maximum temperature of your open palm:  

a. Click or tap View, , and choose Graph and Table.  
b. Look through the data table on the screen and find the maximum (largest) temperature 

value. 
c. Record this value in the correct place on the Data Table. 

7. After you have finished finding the temperature of your open palm, place the Temperature 
Probe on your table and allow it to sit there without being touched. This way, the probe will 
cool down to the temperature of the room. While it cools, continue with the next step. 

8. During this part of the experiment, you will place the Temperature Probe inside the mitten so 
you can measure the temperature inside the mitten. You will not have a hand inside the 
mitten, just the Temperature Probe. 

a. Think about what will happen to the temperature inside a mitten while it is sitting on the 
desk. The Temperature Probe will be inside the mitten but your hand will not be. 

b. Now, guess how high the temperature will be at the end of data collection and write down 
your prediction in the Data Table.  

c. Without touching the Temperature Probe, look at the temperature values in the digital 
meter on the screen. Make sure the temperature is very close to the value you recorded as 
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the room temperature in your Data Table in Step 4. If the temperature is not very close, 
wait until it is. 

d. Place the mitten on the table and slip the Temperature Probe into the mitten. Make sure 
you do not touch the metal part of the probe. 

e. Click or tap Collect to start data collection. Note: The first data set is automatically 
saved. 

f. When data collection is done, look through the data table on the screen.  
g. Find the maximum (largest) temperature value for the Latest data. Record this value in 

the correct place on the Data Table. 
h. Place the Temperature Probe on the table and allow it to sit there without being touched. 

9. During this part of the experiment, you will measure the temperature of your hand inside the 
mitten. 

a. Think about what will happen to the temperature of your hand inside the mitten. 
b. Now, make a prediction about how high the temperature will be at the end of data 

collection and write down your prediction in the Data Table.  
c. Without touching the Temperature Probe, look at the temperature values in the digital 

meter on the screen. Make sure the temperature is very close to the value you recorded as 
the room temperature in your Data Table in Step 3. 

d. Place the mitten on your hand and slip the Temperature Probe into the mitten  
(see Figure 2). Position the tip of the probe in the middle of your palm. Leave your hand 
open during data collection, do not close your fist. 

e. Start data collection. 
f. When data collection is done, look through the data table on the screen.  
g. Find the maximum (largest) temperature value for the Latest data. Record this value in 

the correct place on the Data Table. 

 

Figure 2    
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ANALYZE YOUR DATA 
1. What is the source of heat in this experiment? 

  
  

 

2. If the mitten does not produce heat on its own, then how do mittens keep your hands warm? 

  
  

 

3. Thinking about the previous question, explain the difference between heat production and 
heat retention. 
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Learning to Use a Motion Detector 
You can use a Motion Detector to measure the position of objects as they move. In this activity, 
you will learn how to use a Motion Detector. 

OBJECTIVES 
• Learn to use a Motion Detector. 
• Measure the distance between a book and the Motion Detector. 
• Match a shape by moving a book up and down above a Motion Detector. 

MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Vernier data-collection interface 
Motion Detector  
book 

PROCEDURE 
Part I  Learn about the Motion Detector 

1. Do the following to set up the Motion Detector for data collection:  

a. The detector (gold circle) is located on the part of the Motion Detector called the “head.” 
Rotate the head open as shown in Figure 1.   

b. Locate the switch under the head and set it to the Ball/Walk position (see Figure 2). 
c. Rotate the head back down. 
d. Connect the Motion Detector to the data-collection interface, and then connect the 

interface to your Chromebook, computer, or mobile device. 
e. Launch Graphical Analysis.  
f. Click or tap View, , and choose 1 Graph. This will display a graph of position vs. time. 
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Figure 1    

  

  

Figure 2    

2. Collect data: 

a. Put the Motion Detector on a table or chair with the detector facing up towards the ceiling 
(see Figure 3). Make sure there is nothing in the path of the signal coming out of the 
detector. Note: When you are done collecting data, you will record your observation by 
answering a few questions. You can look at the Observations Sheet in the next step to see 
the questions you will answer. 

b. Have one person stand holding a book about 0.5 meters above the Motion Detector. 
c. Look at the screen and click or tap Collect to start data collection. 
d. Slowly move the book straight upwards and watch what happens on the graph on the 

screen. 
e. Now slowly move the book down toward the sensor, but don’t get closer than about  

15 cm. Watch to see what happens when you move closer to the Motion Detector. 
f. Now, move the book upwards very quickly and watch what happens.  
g. Data collection will stop after 5 seconds.  
h. You can try it again by starting data collection again. 

 

Figure 3    
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3. Use your experiences in Step 2 to complete the statements in the Observations Sheet. 

Observations Sheet 

1.  When I slowly move the book up and away from Motion Detector,   
  
  

2.  When I slowly move the book down and towards the Motion Detector, 
  
  

3.  When I lift the book up very quickly the graph is different than when I move it slowly because 
  
  

 

Part II  Make a snake with the Motion Detector 

 

 

Figure 4    
4. In this part of the activity, you will match the shape of the snake. An example of what this 

might look like is shown in Figure 4. Before you start, think about what happened when you 
moved the book in front of the Motion Detector. Fill in the blanks as a plan for matching the 
shape on the Graph. 

a. Start with the book _______  meters above the Motion Detector. 

b. Move the book ___________ (up or down) so that the book is about _________ meters 

above the Motion Detector.  
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c. Move the book ___________ (up or down) until it is about ___________ meters above 

the Motion Detector.  

d. Move the book ___________ (up or down) until it is about ___________ meters above 

the Motion Detector. 

e. Move the book ____________ (up or down) until it is about ___________ meters above 

the Motion Detector.   
5. Click or tap Collect to start data collection, then follow the plan you wrote in Step 4, trying to 

match the snake.  

6. If the data you collected matches the snake shape on the screen, congratulations! If you want 
to try to match the snake again, just start data collection and repeat the plan you wrote in 
Step 4. 
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Get a Grip! 
In this experiment, you will measure your grip strength. You will see if your grip strength 
changes as you grip an object for a longer time. You will also compare your grip strength with 
your classmates. 

OBJECTIVES 
• Use a computer and a Pressure Sensor to measure your grip strength. 
• See which of your hands has the greater grip strength. 
• Learn what happens to your grip strength as time goes by. 
• Compare your grip strength with your classmates. 

MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct Gas Pressure Sensor 
plastic bottle 
plastic tubing and stopper assembly  

   

PROCEDURE 
1. Assemble your equipment as shown in Figure 1.   

 

  

 

Figure 1    Figure 2    

2. Make sure the valve is in the closed position as shown in Figure 2. 
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3. Launch Graphical Analysis. Connect the Pressure Sensor to your Chromebook, computer, or 
mobile device.  

4. Click or tap Mode to open Data Collection Settings. Set End Collection to 60 s. Click or tap 
Done. 

5. Each person in the group will have a chance to test their griping strength. Decide who will go 
first.  

6. When it is your turn, collect data for your right hand first:  

a. Pick up the bottle with your right hand and begin squeezing as hard as you can. 
b. Have a teammate click or tap Collect to start data collection.  
c. Keep gripping as hard as you can until data collection stops. Do not lean your hand or 

arm on anything!  
7. To find out your average pressure for the time period that you were gripping the bottle, do 

the following:  

a. Click or tap Graph Tools, , and choose View Statistics.  
b. If this was your turn to squeeze the bottle, record the average (mean) pressure for the 

60-second period in Table 1. 

Table 1 

  0–60 s average pressure 
(kPa) 

My right hand   

My left hand   

  
8. Now collect data on your left hand by doing the following:  

a. Pick up the bottle with your left hand and begin squeezing as hard as you can. 
b. Have a teammate start data collection.  
c. Keep gripping as hard as you can, but do not lean your hand or arm on anything!  

9. Do the following to find out the average pressure for your data:  

a. Click or tap Graph Tools, , and choose View Statistics.  
b. If this was your turn to squeeze the bottle, record the average (mean) pressure for the 

60-second period in Table 1. 
10. Repeat Steps 6–9 for each person in your group. Note: The previous data set is automatically 

saved each time you click or tap Collect. 
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ANALYZE YOUR DATA 
1. What happened to your gripping strength during the 60 seconds that data were collected? 

  
  

 

2. Which of your hands is stronger? Use your data to explain your decision.  

  
  

 

3. Do you use your stronger hand to write or do other things? Give examples of what you think 
you could do to make your weaker hand as strong as your strong hand.  

  
  

 

4. What did you learn about your strength in this experiment? Were you surprised? 

  
  

 



   

4 Elementary Science with Vernier 

5. In Table 2, record the 0–60 s results for the strong hand of the other students in your group. 
Calculate and record your group average. Calculate and record the class average for 0–60 s. 

Table 2: Group and Class Results 

Name 
Strong hand average  

for 0–60 seconds 
(kPa) 

   

   

   

   

Group average 
(Group mean sum ÷ number of 
group members) 

 

Class average  

6. How does your grip compare with the class average? 
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Get a Grip! 
In this experiment, you will measure your grip strength. You will see if your grip strength 
changes as you grip an object for a longer time. You will also compare your grip strength with 
your classmates. 

OBJECTIVES 
• Use a computer and a Pressure Sensor to measure your grip strength. 
• See which of your hands has the greater grip strength. 
• Learn what happens to your grip strength as time goes by. 
• Compare your grip strength with your classmates. 

MATERIALS 
LabQuest 
Vernier Gas Pressure Sensor 
plastic bottle 
plastic tubing and stopper assembly  

PROCEDURE 
1. Assemble your equipment as shown in Figure 1.   

 

  

 

Figure 1    Figure 2    
2. Make sure the valve is in the closed position as shown in Figure 2. 

3. Make sure the Pressure Sensor is connected to LabQuest. 
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4. Choose New from the File menu. 

5. On the Meter screen, tap Duration. Change the data-collection duration to 60 seconds. Select 
OK.  

6. Each person in the group will have a chance to test their griping strength. Decide who will go 
first.  

7. When it is your turn, collect data for your right hand first:  

a. Pick up the bottle with your right hand and begin squeezing as hard as you can. 
b. Have a teammate start data collection.  
c. Keep gripping as hard as you can until data collection stops.  Do not lean your hand or 

arm on anything!  
8. Find the average pressure for the time period that you were gripping the bottle:  

a. Choose Statistics from the Analyze menu. 
b. If this was your turn to squeeze the bottle, record the average (mean) pressure for the 

60-second period in Table 1. 

Table 1 

  0–60 s average pressure 
(kPa) 

My right hand   

My left hand   

  
9. Tap the File Cabinet icon to store your data. 

10. Now collect data for your left hand:  

a. Pick up the bottle with your left hand and begin squeezing as hard as you can. 
b. Have a teammate start data collection.  
c. Keep gripping as hard as you can, but do not lean your hand or arm on anything!  

11. Find the average pressure for your data:  

a. Choose Statistics from the Analyze menu. 
b. If this was your turn to squeeze the bottle, record the average (mean) pressure for the 

60-second period in Table 1. 
12. Repeat Steps 7–11 for each person in your group. 
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ANALYZE YOUR DATA 
1. What happened to your gripping strength during the 60 seconds that data were collected? 

  
  

 

2. Which of your hands is stronger? Use your data to explain your decision.  

  
  

 

3. Do you use your stronger hand to write or do other things? Give examples of what you think 
you could do to make your weaker hand as strong as your strong hand.  

  
  

 

4. What did you learn about your strength in this experiment? Were you surprised? 

  
  

 



   

4 Elementary Science with Vernier 

5. In Table 2, record the 0–60 s results for the strong hand of the other students in your group. 
Calculate and record your group average. Calculate and record the class average for 0–60 s. 

Table 2: Group and Class Results 

Name 
Strong hand average  

for 0–60 seconds 
(kPa) 

   

   

   

   

Group average 
(Group mean sum ÷ number of 
group members) 

 

Class average  

6. How does your grip compare with the class average? 
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Exploring the Poles (Without Leaving 
Your Classroom!) 

Magnets have north and south poles. Do you think that the poles of differently shaped magnets 
are in different places? In this activity, you will use the Magnetic Field Sensor to find the poles 
of various magnets, make diagrams of them, and then see how the poles of one magnet make it 
behave with the poles of another magnet. 

OBJECTIVES 
• Make observations about the poles of differently shaped magnets. 
• Diagram the position of the poles of differently shaped magnets. 
• Draw conclusions about the poles of magnets. 

MATERIALS 
LabQuest 
Vernier Magnetic Field Sensor 
several differently shaped magnets (bar, disk, horseshoe, cow magnet, etc.) 
paper and markers or crayons 
small stickers  

PROCEDURE 
Part I  Make a Map of Your Magnets 

1. Set up the Magnetic Field Sensor for data collection:  

a. Set the switch on the Magnetic Field Sensor to the 6.4 mT setting. 
b. Make sure the Magnetic Field Sensor is connected to LabQuest. 
c. Choose New from the File menu. 
d. Bend the tip of the Magnetic Field Sensor so that it looks like the picture in Figure 1. 

Find the white dot near the end of the Magnetic Field Sensor. This is the part of the 
sensor that senses the magnetic field.  



Exploring the Poles (Without Leaving Your Classroom)  

2 Elementary Science with Vernier 

 

Figure 1    

2. Find the north and south poles of one of your magnets: 

a. Choose one of the magnets and trace its outline on a piece of paper.  
b. Place the Magnetic Field Sensor on the table with the white dot facing up towards the 

ceiling. Tape the sensor in place.  
c. Slowly move the magnet over the sensor as you watch the live reading on the screen. If 

you see a minus sign (–) in front of the number, mark that place on your picture of the 
magnet with an “N,” for north. If the number you see has no minus, mark an “S,” for 
south on your picture. 

positive number = south pole 

negative number = north pole 
d. Put a sticker with an “S” on the south pole of the magnet and a sticker with an “N” on the 

north of the magnet. 
3. Repeat Step 2 to find the north and south poles on your other magnets.  

4. Record your observations on the Observations Sheet. 

Observations Sheet  

 

 

 

 

 



Exploring the Poles (Without Leaving Your Classroom) 

Elementary Science with Vernier 3 

Part II  Find How the Poles Interact 

5. Find out how the poles of the different magnets interact with each other.  

a. Choose two of your magnets. Find the north pole of one magnet, and put it right next to 
the south pole of the other magnet. Write down what happens in the Data Table.  

b. Now put the north pole of the first magnet near the north pole of the other magnet. Write 
down what happens in the Data Table. 

Data Table 

Position of the 
Magnets What Happens 

North near 
South  

North near 
North  

South near 
South  

Prediction 

Write what you think will happen if you put the south pole of one magnet near the south pole of 
another magnet. 

I think the south poles of the two magnets will  

  
 

6. Now test your prediction. Write down what happens in the Data Table. 

ANALYZE YOUR DATA 
1. Write down what you have learned about magnets. 
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2. Look at the different diagrams you made. Choose two of your magnets and tell about their 
shapes and where their poles are. 

  
  
  

 

3. Write a sentence that tells how the poles of magnets behave when the same (or like) poles are 
pushed together and when opposite (or different) poles are pushed together. 
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